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1. INTRODUCTION

The P Category Lighting software (PlePcat) produces Spacing Tables which can be used as
design aids in the lighting of Category ‘P’ roads in Australia and New Zealand. Category ‘P’ was
originally introduced in the revised Road Lighting Standard AS/NZS 1158.3.1:1999, released in
November 1999. This Standard has now been superceded by AS/NZS 1158.3.1:2005 which
contains more detail as well as some minor changes and enhancements. Several further
amendments were made in 2008 and 2010.

It is assumed that the user has basic knowledge of the operations of the Windows PC operating
system.

2. INSTALLING THE SOFTWARE

Depending on how the software was purchased it will be provided in either of two forms:-
1. OnaCD-ROM

First, load the CD-ROM into your CD Drive and then click on the Start button, Select Run...
from the menu and type d:\PlePcat\setup.exe (d: is the drive letter of your CDROM) into the
Run dialog box and then click OK.

Search

Help and Support

Type the name of a program, Folder, document, or
Intermet resource, and Windows will open it Far you,

Open: | di\PlePcatisstup, exe w |

I Ok, H Canicel ][ Browse. ., ]

IS
- — e —— e —
ia Start E k-2 08 - b B

Follow the subsequent instructions on the screen to correctly install the P Category Lighting
software on your computer. Generally, it will only be necessary to click on the Next button
several times to carry out the installation.

2. Via Email or Download from the website

Instructions will be provided in the email or on the website on the procedure to install the
software in this case.

It is recommended you choose the default folder eg. c:\Program Files\Perfect Lite (or c:\Program
Files (x86)\Perfect Lite on 64bit operating systems) in which to install the software. If you install
the software in another drive and/or folder then please make a note of the location below for future
reference.

P Category Lighting software installed in drive/folder:
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3.

STARTING THE SOFTWARE

Click on the Start button, select All Programs then Perfect Lite then P Category Lighting from
the menu. (Note: The menu may also show Pedestrian Area Lighting, which is still available for
use, but the LTPs and calculation methods relate to AS/NZS 1158.3.1:1999 - the superceded

Standard.)

ey 1 aeim
FreeCommander | =

rﬁ Petfect Lite g CIE-SAASTAM to IESMA

& Internet Explorer 2= IESMA to CIE-SABSTAN

@ Windows Media Plaver "' P Category Lighting

E Adobe Reader 2

Martan k
Powerarchiver »
‘f; start E Adobe Acrobat 4.0 »

All Programs L]

u PerlLDEatiDn: Z:\Program Files\Perl
! W Cateqory Lighting J

The window as shown below should then be displayed.

Welcome to the Perfect Lite - P Category Lighting Software

Thankyau far choosing from the 'Perfect Lite' range of software faryour
road lighting design needs.

The P Category lighting software should be used as a design aid in
cohjunction with all the recommendations contained in the Puhblic
Lighting Code ASINZS 1158.3.1-2004.

For brief details on aperating this software click the 'Brief Tour' button at
the hottorm ofthis dialog box. This Brief Tour will give you an
appreciation of what the software you have purchased can accomplish,

™ Don't show me this again Brief Tour...

If this is the first time you have run the software then the ‘Welcome to the Perfect Lite....." window
will appear. If you don’t want it to appear again click in the check box adjacent to the text “Don’t

show me this again”.

BRIEF TOUR OF THE SOFTWARE

The P Category Lighting software (referred to as “PlePcat”) mainly produces spacing tables
which can be used as design aids in the provision of lighting for Category ‘P’ roads, paths and
cycleways. Category ‘P’ was originally introduced in 1999 when the (1986) road lighting Code,

AS1158, was revised. The Code has been further revised and is now known as AS/NZS

1158.3.1:2005. The PlePcat software has been amended to meet the changes in the Standard.

© Copyright Trevor Caswell 2005-2012
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Before you produce a spacing table (or generally do anything else in the software) it is necessary
to load (or open) a photometric I-table for the luminaire under consideration. These I-tables would
usually be stored on your computer’s hard drive as a file supplied from the manufacturer or
supplier of the luminaire. To get you up and running the PlePcat software is supplied with a
sample file (LUM2.cie) which corresponds to the one used in the Appendix of AS/NZS
1158.3.1:2005. From the File menu click on Open I-Table.

H Perfect Lite - P Category Lighting - AS/NZS 1158.3.1-2005
ZIEM Wiew Spacing Table Tools Help

Cpen I-Table, .,
Mulki File Mode, ..
Exit

This will then display the screen where the file name is required to be input.

"+ PERFECT LITE - P Category Lighting - AS/NZS 1158.3.1:2005

N ENFIERYETGERE CProgram Files\Perfect LitetLUMZ.CIE j

Cancel | Next --» |

Each time you enter this screen (and most others in the program) the fields will be filled with the
data last input. Should you wish to select a different file then either:-

1) enter the name directly in the I-Table File Name field
2) click the down arrow to the right of the combo box to select from previous files used or
3) click on the Browse button to invoke the standard Window File Open Dialog Box.

to select the appropriate file, example below

© Copyright Trevor Caswell 2005-2012 Page 4



Perfect Lite — P Category Lighting for AS/NZS 1158.3.1:2005 Version 3.07

[ ' i

-
Select |-Table File

Look in: | \) Perfect Lite ﬂ |‘=j< Ed~
: ] 98318.CIE [#Li61.CIE -
_ |®] 95321, CIE [#L7z.cE
Recent =] 95354, CIE |#]Lez7.cIE
|®] 95370, CIE [#]Lumz.cie
@ ] 201045, CIE [#]Lumz.cIe
|#]206218.CIE |®]MimoR.CIE
Desktop /e 206230,C1E =] sampLE.CIE
. |#] 206243, CIE
o7 ﬂFLD?BD.CIE
5| G5214.CIE
My Documents ﬂ L2.CIE
- |#]Los.CIE
55 |®]L1z0.CIE
. ®]L1z2.CIE
by Computer - '
®]L125.CIE
i.} 4 5
-
My Network  File name: [CUM2.CE -~ Open |
Places
Files of type: |CIE Files [".cie] -l Cancel

It should be noted that by default, the dialog box will initially only display all the files with a “cie” file
extension (typical for road lights). If this is not the type of file you are looking for make a choice
from the Files of type drop down list box. When the desired file is in the File name field click the
Open button on the file dialog box to continue on with the software.

When the desired file name has been entered click on the Next button to continue on with the
software. On the following screen input descriptions of the luminaire, initial flux value,
maintenance factor, light source etc..

" | PERFECT LITE - P Category Lighting - AS/NZS 1158.3.1:2005

I-Table File Name: C:\Program Files\Perfect Lite\LUM2.CIE

Header line read from |-Table file: TEST LUM 80W MBF/U
Change data in the fields below to suit your particular job:

Lurninaire Description: | Sample Minor Road Luminaire

Lamp Wattage and Type: | 80 Ywatt Mercury Vapour

Stores Code: (Dptional)
Initial Lamp Flux (Ims): | 3800

Ingress Protection Rating: ™ IP5x IPBx  IP5x - Maximum Maintenance Factor = 0.7

hWlaintenance Factar: | .7 MF‘ Upcast Angle (%) | 3

Light Source: @ fvi © HPS « T5 ( LED .
T MH LRSS O CFL " Other

<_ Back ‘ ok |

© Copyright Trevor Caswell 2005-2012 Page 5



Perfect Lite — P Category Lighting for AS/NZS 1158.3.1:2005 Version 3.07

Inputs in the description fields are only necessary for identification of the luminaire and lamp and
will be included on any output produced by the software. Once again when all the information has
been entered click on the Ok button.

You have now loaded the I-table file into the program and at this point you can view the
photometric I-Table by selecting either of the top two items from the View menu.

" PERFECT LITE - P Categary Lighting - AS/NZS
File BUEPN Spacing Table Tools Help
I-Table with Angles
g I-Table as in File

Last Spacing Table
Light Technical Parameter Table

However, the main thing that we want to do is produce a spacing table (or check on compliance for
a particular spacing). From the Spacing Table menu select Local Roads... . Alternatively, you
could select Pathways (including Cycleways) from the same menu depending on your needs.

! ": PERFECT LITE - P Category Lighting - AS/NZS 1
Help

§ File  View BEEGEGENERES Tools
Loc "
Pathwways (including cycleways). ..

The screen will change to show several input fields to be filled with appropriate data relative to the
table you wish to produce. As this is the first time the software has been run it will have the default
values as used in Appendix B of AS/NZS 1158.2:2005.

“+|PERFECT LITE - P Category Lighting - AS/NZS 1158.3.1:2005

|-Table File Name: C:\Program Files\Perfect Lite\LUM2.CIE
Initial Lamp Flux: 3800 Ims  Maintenance Factor: 0.7  Upcast Angle: 5°

Luminaire Description: Sample Minor Road Luminaire
Lamp Wattage and Type: 80 Watt Mercury VVapour Light Source: MV
Stores Code:

LOCAL AREA ROADS
Job Mare: | Result Validation - Appendixz B of AS/NZS 1158.2

Lighting Category: |P4 -
Limiting LTPs for selected Lighting Categary:
| 65 EN [N r
Arrangement: |Sing|e Sided j
Oftset Distance: l*— m [or*=1/4 Road Reserve or & = 1/2 Road Reserve]
Mounting Height Range: |ﬁ.5 m ta: |?.5 m in increments of ’1— m

Road Reserve Range: |B i to: |23 rm in increments of. | 2 I

M List LTF's for each maximum spacing W Show llluminance values over grid

Cancel | Calculate |
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When any of the ‘standard’ Road Categories are selected eg. P1, P2....P5 then the Limiting LTPs
for selected Lighting Category fields will be ‘greyed out’ indicating the default values (that
cannot be altered). If you select the User Defined Category these fields will be available to input
respective values.

Now might be a good time to talk about the On-line Help accessible from within the software. If
you are in doubt as to what details should be input into any field then simply put the cursor in that
field (ie. Left mouse click in the field) and press the F1 key. A pop-up Help screen will appear
giving you information on the contents of the field and limit of values that can be input etc. This
help feature is available for any item on a Menu, any button or screen displayed. To remove the
Help screen click on the X in top right-hand corner of the Help window. You can check out this
help feature for some of the fields on the current screen.

Anyhow, back to the process of producing the spacing table. Now press the Calculate button to
get the software to carry out the necessary calculations to determine the maximum spacing for the
range of road widths and heights etc. entered. When Calculate is pressed the software first
validates the data in the input fields. If an error occurs, such as a value being out of an allowable
range then an error message will appear such as below.

Height Range: |E.5 m in increments of | 1000 m

m to: | 7.5

lesenallasas o = — 2of. | 2 m
tegory Lighting - Data Yalidation g]

rinance values
@ Increment musk be between 0.1 and 5 metres,

An example of the top part of the resultant spacing table is shown below.

* | PERFECT LITE - P Category Lighting - AS/NZS 1158.3.1:2005 |

1 P Category Lighting - A3/NZZ 1155.3.1:2005

Eo o o o o o o o o o ol o o o o o o o o

Your Comwpany Natne Goes Here

[(Maintained walues)

I-table Filename:
Joh Name:

Luminaire Description:
Lamp Wattage & Type:
Initial Lamp Flux:
Naintenance Factor:
3tores Code:

Upcast hngle:
Arrangement :

Offset Distance:

Upward Waste Light Ratio:
Light Source:

Luminaire Classification:

Lighting Category:

Illuminance Criteria:

[ 24 paye/s approximately, if printed ]

C:wProgrsmm FileshPerfect LiteWLUMNZ.CIE
Result Validation - Appendix B of AS/NZZ 1158.2

SJample Minor Road Luminaire
80 Watt Mercury Vapour

3800 lms

o.7

5 degrees

Single 5Side

1/4 Road Reserwve
2.8 %

MV - Mercury Vapour
Not specified

P4 (Local Area Roads - Tables 2.1 & 2.6)
bverage Illuminance (Eav) >= 0.85 1x

Minirwuwn Illuwinance (Eph) »>= 0.14 1x
Illuminance Uniformity (Up)] <= 10

Save As...

E———

Use the scroll bar on the right side of the screen to move the display up to view the remainder of
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Page 7



Perfect Lite — P Category Lighting for AS/NZS 1158.3.1:2005

Version 3.07

the table.

';lnrnfff‘T TITE N admmmmer D In k8l ACIITC AAED D 4.730NE

Ly

* | PERFECT LITE - P Category Lighting - AS/NZS 1158.3.1:2005 (%]

1 Illuminance Criteria: Average Illuminance (Eawvw) >= 0.85 1x
[Maintained wvalues) Minimwan Illuminatce (Eph) »>= 0.14 1x
i Illuminance Uniformity (Up) <= 10

Caleculation Grid: 20 x 11 points - Figure 3.7 of AS/NES 1158.2
|| Mounting

Height

Maximwn Spacing for different
Road Reserwve Widths

i Bttt e e et +
6.5 | 49 49,1 45 47.6 6.9 46,2 42 38.3 34.5 29.7 21.6 |
: 7.5 | E3.% 53.3 £EZ2.6 51.5 1.0 50.3 49.3 45.3 40.7 36.7 30.9 |
Bttt e e e e et +
Value/s in sbove table are all in metres.
l The tahle contains maximun spacings which, for the specified lwninaire

3 and lawmp cowbination, prowvide cowmpliance with the light technical
paramseters (LTFs) of Table Z.6 of AS/NIZ 1158.3.1:Z005.

Refer next page for list of LTP's at compliant maximum spacings.
h Refer following page/s for illuminance values at grid points.

' PlePcat - Vers 3.05 (Built: Z0/6/11) Run: 20/ 6/2011 at 17:41:47

Save As...

Close

[ 24 payeis approximately, if printed ]

To print out the complete table on your printer click on the Print button and the standard Windows
print dialog box will be displayed. Alternatively, you can save the results to a text file by clicking

on the Save As button.

& Pprint
General ]
:
Select Printer L
ntil |2] Add Prinker s Canon PTAMA P3000 2 Page
oht] I crobat PDFyiriter (a2 hp Laserlet 1320 PCL 6 2 Prog

— Canon PI:MA iP3000 on USE

23 Microsoft %P5 Document iriter <23 Prog

>

£
4
5 Status: Ready
5 Location:
o Comment:
lue Page Range
et e Al
4 1 " Selection
¥t
o r
fer)
fer

[ Printtofile  Preferences
Find Printer...

Mumber of copies: |1 33

Frint |

Cancel |

Select an appropriate printer and click on the Print button to send the printout. Once the printout
has been produced click on the Close button to remove the calculated results and return to the
screen where you can change some values and produce another table. If you don’t want to
produce another table then just click on the Cancel button. This will take you back to the point

where you can make a selection from the menu along the top of the PlePcat window.
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To close down the program altogether select from the File menu the Exit option or click on the X
in the top right-hand corner of the PlePcat window.

*+| PERFECT LITE - P Category Lighting - AS/NZS 1158.3.1:2005

Wiew Spacing Table Tools

Cpen I-Table. ..
Multi File Mode. ..

Help

The other choices from the menu along the top of the window are self explanatory so | won't go
into detail here. If you have doubts then place the cursor over the required menu item and while
holding down the left mouse button press the F1 key and a pop-up Help screen will be displayed.
An example of the one for the Tools Menu is below.

- Perfect Lite - P Category Lighting

1) File Edit Bookmark Options  Help
n Eontents| | Back | Print | | |
4 Tools Menu
[}
~
| "+ PERFECT LITE - P Category Lighting - 4S/NZS 1158.3.1:2005
File Wiew Spacing Table BEEES Help
Upward Waste Light Ratio
Luminaire Intensity Report
Ervironmental Yertical Muminance
Options. ..
Upward Waste Light Ratio
This command will calculate and display the Upward YWaste Light Ratio (UVWLR) for the luminaire -Table
previously selected. Refer Table 2.10 of AS/NZS 1158.3.1:2005 for limiting values of LWYLR for various
classification types.
A detailed description of what LWYLR is can be found in Clause 3.5.2.8 of AS/NZS 1158.0-2005.
This value will be automatically calculated whenever you produce a Spacing Table.
Luminaire Intensity Report
This command will produce a shart report from the luminaire -Table previously selected showing the maximum
intensity values at various angles. These values can be used to derive the Luminaire Classification Type referred
to in Table 2.10 of AS/NZS 1158.3.1:2005.
Environmental Vertical llluminance
This command will calculate and display, for the luminaire -Table previously selected, the minimum distance in
front and behind the luminaire that the Wertical lluminance (Ev) falls to 1 1x. For more details refer to Clause
3.3.3.2 of AS/NZS 1158.3.1:2005.
Options K

Should you have any problems using this software or would like to offer suggestions on future
enhancements contact the developer on: support@ perfectlite.com.
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